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PRESIDENT’S DESK

There has been much discussion lately around the issues of Internet Communications.
| will attempt in this Newsletter to clarify these issues.

N o There are basically two main types of Internet communications

(a) Free member to member only internet systems using Microsoft operating systems and
(b) VOIP - Voice over Internet Protocol.

Programmes which fall into the (a) category are

MSN Messenger with its hotmail system ( www.hotmail.com ) and

Windows Live messenger (www.live.com)

Try this Website Both these systems require either a headset ( earphones & microphone) or a set of speakers and
Selection Tips separate microphone both connected to the Computer soundcard input sockets. They both allow
What Is? communications between members free but do not allow members to contact non-members or
Next Meeting Date national telephone or mobile systems. MSN Messenger has been around for many years and |
Friday have been using this system since the middle nineteen eighties. This system has been added to
September 19" recently by Microsoft with a newer system called Live Messenger.
" However members of MSN Messenger can use
their hotmail addresses on Windows Live. The Here are some of the top comments
addition of a web camera to these two systems will allow members to made by NBC sports commentators
communicate video telephone communications with other members. during the Olympics that they
Before emigrating to Australia | used to call my son in Sydney every would like to take back:
Sunday lunchtime and speak with him via video-phone and be able to
see him and our grandson as well. 1. Paul Hamm, Gymnast:
"| owe a lot to my parents, especially my
The other advantage of these systems is that you can access your e- mother and father."

mail at this programme’s message bank anywhere in the world from 1 _
any computer. Very useful, if you are fortunate enough to go overseas 2 Boxing Analyst:

on holiday. "Sure there have been injuries, and
even some deaths in boxing, but none
Programmes which fall into category (b) are of them really that serious."

Skype and Firefly.

Skype (www.skype.com) is more popular for worldwide useage. It
offers free calls between Skype members anywhere in the world and
has no monthly charges. However you need to prepay a small amount

3. Softball announcer:
"If history repeats itself, | should think
we can expect the same thing again."

into your account to be able to send calls out to non-member
telephones. An example of charges are as follows: Australia calls 0.027¢c/min. Mobile Australia 0.264c/min. 1300 calls
0.323¢c/min. Canada 0.027c/min. USA 0.027¢/min. and UK 0.027c/min.

Firefly (www.freshtel.net) is an Australian programme and also offers free calls between members. They have a free
service with no monthly fees and also several monthly fee services with reducing rates per call as monthly charges
increase. Some free monthly call charges are as follows:

Australia 12.5 ¢/ 180mins.max. Mobile Australia from 15¢/min. UK 2,1¢/min. USA 2.3c/min. The same equipment as
per listed above is required for these programmes and in addition there is a choice of special telephones which can be
purchased. Emergency calls cannot be made on these systems. This is just a quick overview of these systems and |
hope that it will assist you in making a choice if you wish to join the growing number of people using VOIP systems for
their communication. It is perhaps interesting to note that most of the advertising calls you receive are using VOIP
technology!

Enjoy your Computer John Eland



FROM THE SECRETARY

Hello Computer Pals,

How time is flying with two thirds of the year now gone. A warm welcome is extended to the New Members
since the last meeting. These are Nada Curac, Mervyn Field, Richard Harwood,
Claire Jack, Carol Aviani, Kristine Kasby and Gwen Scott.

May you all enjoy your time of learning with us.

It would be lovely to see you all at our next workshop when all the computers will be up and running and
Tutors will be available for any questions and Demos. Any friends and visitors are most welcome.

REMINDER

The next meeting-cum-workshop of Computer Pals Galston
Will be at Histor¥| Cottage 412 Galston Road, Galston

On Friday 19" September, 2008 at 10.30 am

Please would the following people bring a plate for tea and if unable to do so , please let me know.
Keith Horam, Margaret McKinley, Ross Astil, Gwen Scott, Celia van Tilberg, Michelle Hindmarsh

Marganet 9651 2475

YOU MAY FIND SOME OF THE TIPS IN THIS NEWS LETTER DIFFICULT IF YOU HAVE VISTA OR OFFICE 2007

GOOD ADVICE ON INTERNET SECURITY

There are 90 billion emails sent throughout the world every day: and of these 90% (81 Billion)

are spam and 65 billion of these will have links to malicious software. The ‘Russian Business Network’ is
responsible for 65% of online crime. It is important to remember that unsavoury material on the internet is much more
likely to be a haven for malicious software.

FIVE SIMPLE STEPS TO ONLINE SECURITY

Install, Update and use your security software

1. Use strong passwords and change them regularly
2. Be careful when sharing personal information on line

3. Think before you click — if it looks too good to be true, it probably is.
4. Be smart and stay informed

SkipThe Recycle Bin
Every now and then you need to really delete a file.

-

Well, most people delete the thing, then go to the recycle bin and remove it from there. It works, but
there's a better way.

Next time you are 100% sure, without a doubt, for certain, that you want to delete a file, hold your Shift key down while
you delete. The file will be deleted - skipping the Recycle Bin completely.

Word Question and Answer

How can | find out what the buttons on the toolbars do?

Choose What's This? from the Help menu. The mouse pointer will turn into a pointer with a "o symbol. Click on any
button (or any other element or object on the screen) and Word will give you some information.

Also, Shift+F1 will turn on the What's This? Feature.



Can | turn the Ruler off (or turn it back on)?
Choose Ruler from the View menu (if the Ruler is on, then you'll see a tick next to Ruler).

Click on the tick to remove the ruler and click on the little empty box to put the ruler back on again.

How can | display more toolbars? (Not in Office 2007)

1. Choose Toolbars from the View menu.
=" 2. Select the toolbar you want (an active toolbar has a tick next to its name).

3. ALWAYS have the Formatting and Standard toolbars ticked.

How do | move the toolbars?

Click on the left edge of the toolbar (the mouse pointer will turn into a four-headed pointer).
Drag the toolbar to any edge for a toolbar or anywhere else on the screen for a floating palette.

Here is a little verse, which will
show you why you should not rely
entirely on
Spellchecker to pick up your
spelling errors. Type it into a word
document and have
“Spell check” find the errors.
Eye halve a spelling cheque
It came with my pea sea.

It plainly marquees four my revue
Miss steaks eye kin knot sea.
Eye strikes a key and type a word
And weight four it two say
Weather eye is wrong oar write.
It shows me strait a weigh.

As soon as a mist ache is maid
It nose bee fore two long,
And eye can put the error rite
Its rare lea ever wrong.

Eye have run this perm threw it
| am shore your pleased two no.
Its letter-perfect awl the weigh
My chequer tolled me sew.

WHAT IS A VIRUS

It is a program that has been deliberately

created to cause computer problems, usually
v minor ones as a prank, but occasionally very

nasty ones indeed, such as erasing your entire
A hard disk. Viruses were originally designed to
attach themselves to programs on a disk, and
then "hide" in the computer's memory once the
host program is executed, and "infect" every disk they come
across. Some types of virus (such as the famous "l love you")
propagated by email, disguised as an attachment, which is why
you should never open an attachment you are unsure of.

W

WHERE IS THE WINDOWS KEY
It is an extra key on keyboards made after 1995,
located between Ctrl and Alt and bearing the
Microsoft Windows logo. Pressing this key should
immediately bring up the Taskbar with the Start
Menu open. (If your keyboard doesn't have a
Windows key you can perform the same task by pressing
Ctrl+Esc).
If you hold down the Windows key and the E key together you will
bring up Windows Explorer.

What is PHISHING
It is an internet scam in which a forged

How to Send a photo by email

Select the picture in My Pictures.

Right click once on picture.

Scroll down to "send to" .

Left click on "mail recipient" .

A message will appear:

Windows can resize the pictures you send in email so that they
transfer faster and are easier to view by the recipient. What do
you want to do?

Make all my pictures smaller, Click OK.

A new email message will appear automatically with the

message from a bank provides a link for you
to go to their website and "confirm your
details" - but the website is a fake, and if you
do enter your details they will be used to
steal all your money. Note that a legitimate
email from your bank should be addressed to
you personally rather than "Dear customer"
etc, and will never ask you to enter your PIN.

pictures attached. You can now type in the mail recipient’'s address and message, then click send.




WHAT IS A FILE?

All information on a computer is stored in files, whether it is part of a program,
a document created by a user,

a picture, or anything else.

Most software is made up of d0zens, sometimes hundreds, of different files.
WHAT IS READ ONLY?

A read-only file has been set so that it cannot be altered or deleted. Also called write-protected. You can
make a file read-only in Windows by right-clicking on it and ticking the "read-only" box under attributes.

ARE YOUR SCROLLBARS TOO SMALL?

Do you have a hard time grabbing them with your mouse pointer? Well, you'll be both thrilled and delighted to know
you can adjust their size. Here's how: Windows XP.

1. Right-click your desktop and select Propetrties
2. You'll be presented with a settings screen,
select the Appearance tab.
3. The second drop down box shows a little box labelled "item",
select "Scrollbar" from it.
4. You'll be able to increase or decrease the size of your scrollbars by
using the little box to the right of the drop down box labeled "size".
| have mine set to 18.
That's it. You should now be able to make your scrollbars as big as you like.

HAVE YOU TRIED THIS WEBSITE?

http://maps.qoogle.com.au/help/maps/streetview

In the Search Box type in an address and click SEARCH MAPS, you will see the chosen place (hotel or home
etc as long as it is on a street) and be able to look up and down the street by using the arrow keys at top left
of picture, or by dragging the mouse across the picture. You can also zoom and make the picture fill the
screen.

On the map the little man must touch a blue outline of the street to get a picture.

SELECTING TIPS IN WINDOWS EXPLORER

1. Click the first item on the list you would Frn St

= —n like to h lected Bt ConpueTys 0482001 09 pyeces 8ok
Computer Tips 10-08-2001 [CPU upgrades &link colars IKe 10 have selectea. i mpuier1gs pgrates Sl s
Comptuer Tips 10-09-2001 [computer music & dragging Campter Tips 30-03- 2001 computer music &chagaing ik
Computer Tips 10-10-2001  defauit explorer & fi not IES Y N =YV SRVVICY =Y holdlng down the SHIFT key Computer Tips 10-10-2001 [ defauttexplorer & fie not found rick]
Comptuer Tips 10-11-2001 [ stubborn downloads & har click thé last item vou would ’ Comptuer T 10-14-2001 [ stusborm downloads &hard toread wep pagy
Computer Tips 10-12-2001 [drop box trick & ez wallpap h y Computer Tips 0-12-2001 cropbox bk ez welppeig]
e e like selected. 1 Computer Tps 10-15-2001 [anert ward saves & printer tickto save mand

That's it, the first and last selected items are

. now highlighted, as well as everything in
Computer Tips 10-13-2001 [expired pages acobmn s DEtween. 1 Computer Tps 10-18-2001 [odd web page errrs & fing shut down prob

S steve Computer Tips Spedial Edition 10-22-2001 [ Win XP qued

OK, so what if you just need specific items selected, not whole sections?

That's easy too. Hold down the CTRL key while making your selections. As long as the CTRL key is down, you can

click and select individual items.

The Next Meeting for Computer Pals

Galston and District Bt e Sl astoy
Will be at History Cottage 412 Galston Road, Eh°“‘_’]- 9651 2175
Galston -mail gransy@tpg.com.au

on Friday 19" September, 2008
Time 10.30 am




